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INTRODUCTION 
The Planning Department GIS Lab maintains a virtual 3D model of the City as a resource of 
public information available for all to download. It is intended to aid 3D modelers, planners, 
and urban designers as a background context for 3D design software. The citywide 3D 
model is a snapshot of the City of Boston in 3D at a specified point in time. This 
downloadable city model is updated on a semiannual basis.  

AVAILABLE 3D FORMATS 
The Citywide 3D model is constructed of several components: Terrain, Groundplan, and 3D 
models of buildings. Each of the city-model components is made available in open-source 
data formats, and as an all-in-one SketchUp format model that combines all of the 
components in one model per tile that can be imported into most 3D modeling 
applications. 
 

 
 
 
Use the interactive 3D Data Download Map on our website to find and download 3D data 
for different parts of Boston. 
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GENERAL INFORMATION 

TILING STRATEGY 

The Citywide 3D Model utilizes the CitySchema workspace to manage and update the 
virtual city model. lt utilizes a tile grid as the framework to organize model collections, 
aerial photography, and terrain meshes. These modules seamlessly connect and can be 
layered with various tiled ground plan images.  
    
COORDINATE SYSTEM - METRO BOSTON 3D 

STATE PLANE MASSACHUSETTS MAINLAND 

UNITS: FEET 
HORIZONTAL DATUM: NORTH AMERICAN DATUM OF 1983 (NAD 83)  
VERTICAL DATUM: NORTH AMERICAN VERTICAL DATUM OF 1988 (NAVD 88)  

 
OFFSET AND ORIGIN 

The Metro Boston 3D coordinate system places the origin to the South-West of Boston and 
neighboring cities. Preserving the insertion point and tile boundaries in models simplifies 
the transfer of geo-located models across different projects. The origin of the Metro 
Boston 3D coordinate system serves as the insertion point for models. 

ORIGIN COORDINATES 

X: 731,100 MA STATE PLANE FEET  
Y: 2,902,900 MA STATE PLANE FEET 
LONGITUDE: 71.223391 W  
LATITUDE: 42.213379 N  
ELEVATION: 0  
EARTH MODEL: WGS84  
ROTATION TO ALIGN WITH TRUE NORTH: CLOCKWISE 0.34 DEGREES  
 

OBJ ORIENTATION 

Many modeling tools treat the Y axis as vertical. Geographical coordinate systems use a 
Z-Up, Y-Forward orientation. If you experience mis-orientation when importing OBJ 
format models into your design projects,check the orientation options in your importer. 
The Z-Up orientation is sometimes obtained by rotating the model -90 degrees around the 
X axis. 
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1. ALL-IN-ONE SKETCHUP MODEL (.SKP) 

FILE NAME: 

BOS_[TILE]_SKETCHUP_[ISSUEDATE].SKP 

LAST UPDATE: 1/28/2025  

FORMAT: SKETCHUP 2015 (.SKP)  

DESCRIPTION: The SketchUp models combine 
all of the citywide model components into a single 
model per tile. They use a tag system to control 
what is visible. Each building model is grouped 
and named with unique identifiers referring to 
Boston's 3D Tiled Building Collections documentation. 

SOURCES: For information about sources, visit the metadata page for each of the 
components: 

● Terrain Mesh 
● Aerial Photo 
● Building Model Collection 

COORDINATE SYSTEM: See General Information Page 

For more details and tips on the coordinate system, visit 
https://www.cityschema.org/tile_scheme/index.htm 

OFFSET AND ORIGIN: See General Information Page 

OBJ ORIENTATION: See General Information Page 

USAGE NOTES: 

● The terrain looks better if you use the Window > Soften / Smooth Edges to soften 
coplanar edges within 50 Degrees. 

● To skin the terrain with the 2021 Aerial photo or any other base map image clipped 
to the Metro Boston 3d tile scheme, use the Materials > Eyedropper to select the 
terrain material, then choose the desired ground planimage in the Edit tab. 

● The tile frame included with each SketchUp model can be used to register models 
with neighboring tiles or with the city-wide tile grid. The elevation of the tile 
polygon is always 0. 

GEOREFERENCE: 
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To georeference your SketchUp model for interoperability with SketchUp's Geo-Location 
features, including export of properly located KMZ files: 

● Load the SketchUp tile grid and see the latitude and longitude references for tile 
centers and corners. 

● Choose a tile center or corner to be the origin point for your model. This works best 
for models that are just one or two tiles wide. 

● Select all and click your chosen origin point with the Move tool 
● Type [0,0,0] - which should appear in the Measurement Box (lower right corner of 

the SketchUp window.)Your model origin should now be at your chosen point. 
● Click your origin point with the Rotate tool and begin a clockwise rotation. Then 

enter 1.3 (degrees) in the Measurement box. This orients your model to the local 
Universal Transverse Mercator grid, which SketchUpexpects. 

● FInally, Go to Model Info > Geolocation and enter the latitude and longitude for your 
origin point. 

● Test your geolocation by trying to add some imagery from File > GeoLocation > Add 
Imagery 
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2. TERRAIN MESH (.OBJ) 

FILE NAME: 

BOS_[TILE]_TERRAINMESH_2011.OBJ 

LAST UPDATE: 11/15/2023  

FORMAT: WAVEFRONT OBJECT (.OBJ) 

DESCRIPTION: The tiled terrain models provide a 
precise reference for placing and visualizing 3d 
models. They can be used to represent the initial 
conditions for detailed design studies. These models 
also provide an accurate terrain reference for shadow 
and visibility studies. 

SOURCES: 
● Boston terrain observed April 2011 
● Outside Boston, terrain represented with MassGIS 2005 DTM 

COORDINATE SYSTEM: See General Information Page 

For more details and tips on the coordinate system, visit 
https://www.cityschema.org/tile_scheme/index.htm 

OFFSET AND ORIGIN: See General Information Page 

OBJ ORIENTATION: See General Information Page 
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3. BUILDING MODEL COLLECTION (.OBJ) 

FILE NAME: BOS_[TILE NAME]_BLDGMODELS_OBJ.ZIP 

LAST UPDATE: 1/28/2025 

FORMATS: WAVEFRONT OBJECT (.OBJ), 

COMMA DELIMITED (.TXT), GEOJSON 

DESCRIPTION: Our open-format model 
collection is a compressed archive of individual 
OBJ building models located within the tile area. 
The Wavefront OBJ file type is an open source 
file type ideal for sharing and archiving 3D 
models.  
 
FINDING MODELS IN THE COLLECTION:  
Each tile's model collection consists of a zipped 
folder of obj files that are named with the unique 
model identifier.  
 
The ModelFinder.htm file is a simple html 
reference tool intended to be used in the browser to search for models within a tile. It is a 
Javascript / Leaflet application that presents a clickable model index map that sorts models 
according to their current, proposed or historical status. Clicking a model on the map 
opens a pop-up with a table of that model's attributes and a link to the model file in the 
collection.  
 
The included catalog.csv file is a reference table for the collection of model files in the objz 
folder. The Data Dictionary explains the attributes of this table and how they are used to 
classify the models.  

SOURCES: Models come from a variety of sources and methodologies and dates. The 
provenance of each model is recorded in its catalog attributes: Model Credit, Model_Date, 
Survey Source, Survey Date explained in more detail in the data dictionary, below. 

COORDINATE SYSTEM: See General Information Page 

For more details and tips on the coordinate system, visit 
https://www.cityschema.org/tile_scheme/index.htm 
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OFFSET AND ORIGIN: See General Information Page 

OBJ ORIENTATION: See General Information Page 
 

DATA DICTIONARY FOR MODEL COLLECTION 
The Bos3d City Model Collection is organized according to the CitySchema Data 
Dictionary. This model management schema provides a system of attributes that can be 
used to understand the provenance of models and track them  through their life-cycle. The 
Model Catalog is a single table with a reference for each model in the structure model 
collection. The model catalog can be found in each collection as the catalog.csv file. 
 
GENERAL ATTRIBUTES 

These attributes are used to determine whether or how the model should appear in various 
scenarios involving the time period, or planning context. These are the attributes most 
often used for controlling the styling of models and the attributes most frequently updated 
in the model management workflows. 
 

NAME 
TEXT 

The name of the structure. This may be the name of an existing or 
proposed structure or this could be the address taken from the parcel 
intersected by a model's centroid. 

STATUS 
TEXT 

A phase in the life cycle for proposed, built, demolished or renovated 
structures. Values of Status are taken from the  Status_Code domain (see 
below) 

APPEAR_DT 
DATE 

Date of the latest observation or document that confirms the current value 
of Status. The Appear date should refer to the same document referred to 
in the Appear Source fields. 

APPEARSRC 
TEXT 

The observation or document that confirms the Appear_Dt. 

DISAPP_DT 
DATE 

When the structure was demolished. Usually the date of the earliest 
observation that confirms that a structure has been demolished or 
substantially renovated. 

DISAPPSRC 
TEXT 

A reference to the document that established the Dissap_Dt. The 
Disappear Date should refer to the same document referred to in the 
Disappear Source fields. 
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PROVENANCE ATTRIBUTES  

Information for understanding the provenance of models as documents that have authors, 
contributors, sources and issue dates. 
 

MODEL_ID 
TEXT 

A unique ID for each model. The ID is a random arrangement of seven 
upper-case letters and numerals prefixed with “BOS_”. This is the name of 
the .obj model in the model collection.  

MODEL_CRED 
TEXT 

Reference to the person or enterprise responsible for creating the model. 

MODELBATCH 
TEXT 

A folder within the Archive/ModelWork folder where the original source file 
can be found. 

MODEL_FILE 
TEXT 

Name of the original source file for the model. 

MODELSTORE 
TEXT 

Name of the model store holding the open-format model in the Archive 
Repository. The value of this field is normally set automatically when 
producing Geodatabase andModelStore snapshots of the collection. The 
ModelStore string is combined with Model_ID to create path references 
and URL end-points for open-format models. 

MODEL_DT 
DATE 
 

Date when the model was created. This value should reflect the date that 
the model was enrolled in the collection. In the case of modified models, it 
should reflect the date that the modified model was enrolled. This field will 
be used to discover updated models. 

MODELNOTE 
TEXT 

This is the text that would appear as the description of the model. This note 
might describe the context of the model's creation. This note might also 
reflect technical aspects of the model, for example, if the model has been 
modified. 

MODEL_LOD 
DOUBLE 

Levels of Detail 
 

SURVEY_SRC 
TEXT 

The observations that were used for establishing the shape of the model. 
Should describe the responsible party and the methodology where possible. 

SURVEY_DT 
DATE 

The date that the model geometry was captured or published. 
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GEOMETRIC & REFERENCE ATTRIBUTES 

These attributes describe the geometric positioning of the model and how it is referenced 
in other geographic databases: parcels, tile grid, Google Maps, etc. 
 

CENTR_LAT 
DOUBLE 

Latitude of the model centroid (2D) in decimal degrees.  

CENTR_LON 
DOUBLE 

Longitude of the model Centroid (2D) in decimal degrees.  

CENTR_X_FT 
DOUBLE 

X coordinate (Feet) of the model centroid in the Metro Boston 3D 
coordinate system. 

CENTR_Y_FT 
DOUBLE 

Y coordinate (Feet). See above. 

MIN_EL_FT 
DOUBLE 

The lowest elevation of the model. This may be below ground. 

MAX_EL_FT 
DOUBLE 

Elevation of the highest point of the model. 

GND_EL_FT 
DOUBLE 

The elevation where the model intersects the ground. This measure uses 
vertices of the 2D footprint to sample elevations. 

HEIGHT_FT 
DOUBLE 

The relative height from the Max Elevation of the model to the lowest 
corner. 

TILE_ID 
TEXT 

ID for the tile that the model centroid falls within. 

PARCEL_ID 
TEXT 

The Parcel ID for the parcel that falls under the centroid of the model’s 
footprint. 

PARCEL_LNK 
TEXT 

A url that opens the Assessor’s web map centered on the parcel that is 
identified by theParcel_ID. 

GOOGLELNK 
TEXT 

A url that brings up an oblique view of the building in Google Streetmap. 

NEARMAPLNK 
TEXT 

A hyperlink that brings up an oblique view of the building in NearMap. 
Requires aNearMap login. 
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PROJECT ATTRIBUTES 

Attributes for models that are in the development process, either approved or under 
construction. 
 

PROJECT_ID 
TEXT 

The Project ID in the City of Boston Planning Department’s Article 80 
Development log. 

PROJECTLNK 
TEXT 

A URL linking model to the project’s landing page on the City of Boston 
Planning Department website if applicable. 

A80STATUS 
TEXT 

The latest status associated with the project in the Article 80 
Development Log. 

PLAN 
TEXT 

For models associated with proposed or internal studies, the name of the 
overall plan that may cover multiple buildings, phases or scenarios. 

SCENARIO 
TEXT 

For models that are part of alternative scenarios within a plan. The value 
for Scenario can be used to identify or select all of the models associated 
with an alternative scenario. 

PHASE 
TEXT 

For models within a plan or scenario that are contingent on time and/or 
grouped by geography. 

LEGCLASS 
TEXT 

This field provides flexibility of controlling symbolization of models for 
webscenes and other cartographic products. 
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STRUCTURE ATTRIBUTES 

These are attributes that refer to the real-world or proposed structure/s represented by 
the model. 
 

STRUCT_ID 
TEXT 

If there is a table about structures, this would be a reference to the 
primary key of that table. 

STRUCT_TYPE 
TEXT 

Type of structure. See domain values. Refers mostly to the physical 
aspect of the structure. 
Must have one of the following values: Building, Bridge, Wall 

STRUCT_USE 
TEXT 

Use of the structure. More specific than Type. Refers to the functional 
aspect of the structure. 
Examples: School, Library, Civic, Residential, Commercial, Subway 
Headhouse, BusShelter 

STRUCT_LNK 
TEXT 

A URL that provides more information about the structure. 
For example, a Wikipedia page or a library branch page. 

 
 
EDIT TRACKING ATTRIBUTES 

These fields are automatically assigned during the management of the model to help track 
edits. 
 

RECINITDT 
DATE 

The time stamp for the creation of the table row. This defaults to the 
time that the feature class was issued. Automatically generated. 

RECINITUSR 
TEXT 

The username for the person who initialized the row. Automatically 
generated. 

RECMODDT 
DATE 

The time stamp for the last modification of the table row. Automatically 
generated. 

RECMODUSR 
TEXT 
 

The username for the person who last modified the row. Automatically 
generated. 

EDITOR 
TEXT 

The user name for the person who did the last meaningful change to 
this record. 

EDIT_DT 
DATE 

The timestamp of the last deliberate edit. 
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EDIT_ACTION 
TEXT 

Explanation of the last deliberate edit. 

QA_FLAG 
TEXT 

Short code used to redirect models to procedures in the model 
management process. Pre-coded domain consisting of: 
3D Edit, Promote Status, Demote Status, Stop, Alt 

QA_ISSUE 
TEXT 

Use this field to explain any issues with the model or catalog 
information that may need addressing in the model management 
process. 

 
 
MODEL STATUS DICTIONARY 

The Model Collection is organized into Model Status Classes. Individual structure models 
are sorted into these classes according to the value of their Status attribute. Changing the 
Status will cause these models to be sorted into a new Feature Class when the database is 
updated. 
 
FEATURE CLASS  

The category of model according to their Status value. This allows models to be filtered and 
displayed according to their physical existence in the real world.  
 

FEATURE CLASS DESCRIPTION 

EXISTING_MP Comprised of structures that are currently in existence whose models 
are measured with photogrammetry or LiDAR and drawn according to 
those measurements.  
Status: Existing, Approved Demo 

HISTORY_MP Holds models reflecting the shapes of structures that once existed. 
Status: History 
 

APPROVED_MP Holds hand-made models reflecting projects under development. 
These models are shared with the public having  
Status: Approved, Under Construction, Current 
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MODEL STATUS  

A category scheme that reflects the life-cycle state of the building or proposal that the 
model represents. This field controls when the model is rendered in applications. The 
GIS-Based model management applications use Model Status to segment the collection 
into feature classes that streamline applications that may be focused on the current, 
proposed or historic views. 
 

STATUS FEATURE 
CLASS 

DESCRIPTION 

CURRENT EXISTING_MP This status is for models of existing structures that 
are based on measurements. 

APPROVED DEMO EXISTING_MP A structure that overlaps with a model that has status 
Approved.The Approved Demo status is used to hide a 
model when portraying Approved projects. The 
building still exists according to the latest 
observation. This observation can be recorded using 
theDisappear Source attribute. 

HISTORY HISTORY_MP A measured model that has been replaced by a newer 
model in the Existing_MP feature class or by models 
in Approved_MP that have been promoted to Under 
Construction or Complete. 
History status may be applied to models of clumps of 
structures where a new model is replacing part of the 
historical model. In these cases, the entire old model 
is historical. Such a model may be flagged for splitting 
(QA_Flag = 3dEdit) to be divided to create a pocket 
for the new model. The original model (the entire 
clump of structures) has status History. The 
remaining part(s) of the model will be kept in the 
existing collection with status Current. 

BOARD 
APPROVED 

APPROVED_
MP 

The building project has been approved by the 
planning board. 

COMPLETE APPROVED_
MP 

Hand-made models of proposals. The shell of the 
building including external finishes appear to be 
complete. These models remain in the Existing 
feature class until they are replaced with measured 
models. This status is used only for hand-made 
models of proposed projects. 

UNDER 
CONSTRUCTION 

APPROVED_
MP 

The foundation (or more) of the new building is 
visible. 
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GUIDELINES FOR 3D MODEL STRUCTURE AND LEVEL OF DETAIL 

 
The architecture of this schema is well suited to handling mesh objects that represent only 
the exterior shell of the structure. It is preferable that the mesh be a closed “solid” that has 
all of its faces oriented toward to outside. Within this guideline, there are many possibilities 
for levels of detail as listed in the table below. 
 

● Models that are not closed or include two-dimensional planes with single faces are 
problematic and can behave unpredictably with regard to shading, importing, and 
exporting. 

● We are unable to publish models that incorporate textures or materials at this time. 
We may be able to represent these as multipatches, but the textures or materials 
will be stripped  when the models are exported to SketchUp or OBJ. 

● Level of detail (LOD) 3 is preferred. If models of building shells may be divided when 
building parts have distinct functions, like parking structures. Or when parts have 
different construction dates. 

● Models of LOD 4 or greater require a lot of work to assimilate and may be impossible 
to clean up to the point of working within the citywide 3D model. 

 
3D MODEL LEVELS OF DETAIL 

 
These levels of detail are compatible with the CityGML LOD scheme but are subdivided 
according to the types of rough massing models that we commonly see shared by 
architects and other 3D modelers. 
 

CODE DESCRIPTION 

LOD 0 Polygon Footprint 

LOD 1 Extruded Polygon Footprint 

LOD 1.5 Massing model made from extruded roof prints when a structure with 
parts that have different heights. 

LOD 2 3D roof detail, extruded to the ground along drip-line. 

LOD 2 Model portrays undercuts where appropriate. E.g. entryways, porticos or 
arcades. 

LOD 3.25 Architectural details indicated by materials or image textures. 
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LOD 3.5 Building model expresses the location of windows and entryways as 3D 
indentations. 

LOD 4 Model is divided horizontally as individual stories. 

LOD 4.5 Model divides interior spaces: rooms or zones. 
 

 

4. GROUNDPLAN (.JPG) 

FILE NAME: BOS_[TILE]_GROUNDPLAN_2011.JPG 

LAST UPDATE: 11/15/2023  

FORMAT: JPEG 

DESCRIPTION: The 2011 Base map layer provides a 
reference map showing saved and planted areas, 
street names, pavement markings.In all, 20 layers 
from the Planning Department GIS Lab were 
graphically ordered and styled and then clipped to 
each tile boundary.The original layers were 
developed from stereophotogrammetric methods, 
with a precision of about six inches. Areas outside 
the Boston city Limit are filled in with base map data 
courtesy of MassGIS. The cell size is one foot per 
pixel. 

COORDINATE SYSTEM: See General Information Page 

For more details and tips on the coordinate system, visit 
https://www.cityschema.org/tile_scheme/index.htm 

OFFSET AND ORIGIN:  See General Information Page 

USAGE NOTES: These images have extents that align precisely with the tile boundaries 
of the Metro Boston 3D Tile Grid. This allows them to be easily and precisely registered for 
draping on tiled terrain and SketchUp models. 
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5. AERIAL PHOTO (.JPG) 

FILE NAME: BOS_[TILE]_ORTHOPHOTO_2023.JPG 

LAST UPDATE:  5/25/2023  

FORMAT: JPEG 

DESCRIPTION: The tiled aerial photo layer is a true 
color, true-ortho rectified aerial photo with a pixel 
resolution of one foot per pixel. 

SOURCE: Nearmap 2023 

COORDINATE SYSTEM: See General Information 
Page 

For more details and tips on the coordinate system, visit 
https://www.cityschema.org/tile_scheme/index.htm 

OFFSET AND ORIGIN: See General Information Page 
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6. VECTOR GROUNDPLAN (.DXF) 

FILE NAME: 

BOS_[TILE]_GROUNDPLAN_DXF.DXF 

LAST UPDATE: 11/15/2023  

FORMAT: AUTODESK DRAWING EXCHANGE 

FORMAT R.14 (.DXF) 

DESCRIPTION: Vector information from several GIS 
layers has been exported to DXF format for the 
convenience of users of design tools including 
autoCAD, Rhino or Adobe Illustrator.They can be used 
as a location reference, source layers for modifiable 
ground plan linework, digital terrain models and 
extrudable building footprints. 
 

● Planimetric Groundplan Layers - edge of pavement, shorelines, etc. (Infotech, 2011) 
● Digital Terrain Model Breaklines and Masspoints (Infotech, 2011; MassGIS, 2005 ) 
● One-foot Contours (Elevated) (Infotech, 2011 ) 
● Building Model Footprints (City of Boston Planning Department 3D Model, 

September 2023) 
● Openspace Boundaries (MassGIS, 2023) 
● Property Parcels (Boston Assessing, 2023) 

 

COORDINATE SYSTEM: See General Information Page 

For more details and tips on the coordinate system, visit 
https://www.cityschema.org/tile_scheme/index.htm 

OFFSET AND ORIGIN: See General Information Page 

USAGE NOTES: Be sure to specify units of Feet when importing DXF layers related to the 
Boston 3D model. 
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